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Getting Started with DC Millennium

DC Millennium isan easy to use audio restoration program, but it’s also one of the most powerful
audio tools available. Unlessyou have used the program before, or you happened to be born already
knowing how to useit, you will probably need to learn your way around.

This guide will do that. 1t'll take you by the hand and lead you, step by step, thru the actual use of the
program. Hopefully, you'll find it agreat info to Millennium, and it’Il make you smile here and there.

Thisismust reading. You'll find it easy and fun!
This guide is divided into two Sections:

1. Aninstalation and getting started guide which tells you how to install the program, setup your
soundcard, and hook up your audio devices to your computer. Even if you already know that your
computer is able to both record and play audio, you should still at least skim this section-
especially the part about testing your system.

2. A very detailed Step-by-Step guide that leads you thru afull audio restoration. In our guide, we'll
clean up avery noisy recording made from an early 1920s recording.

Section One — Setting up and Testing your System for use with DC
Millennium.

You'll want to go thru this section if you are not sure how to record audio from your records or tapes.

Step One — Make Sure System Meets Our Requirements

Most machines today are more than capable of handling audio processing. Hard drives have also grown to
apoint, where you really have no limits on what you can do...except perhapstime. Aswe ve not yet
developed time manipulation outside of the computer, let’s just deal with what you'll need in the way of a
PC.

300 MHz Pentium or better. (Note: Real time or faster performance can be achieved on all
algorithms when using platforms based on 300 MHz Intel Pentium processors, or better.
Previewing multiple filters will require a faster processor.)

16 hit Stereo Sound Card with line level inputs, or a"Digital Only" Card. *

32 Mbytes of RAM for Win 98SE, 128 Mbytesfor XP **

Windows 98SE, Windows ME, Windows 2000, or Windows XP

Audio Source Material

An Audio Delivery System (to match whatever source recordings you have) such asa
turntable/preamp, tape player, etc.

A Hard Drive with enough space to accommodate your Wave files. A CD audio recording
takes about 10.4MB per minute of stereo audio, but we recommend you have about 2.5GB
free to make afull audio CD. (The program only requires about 5 to 14 Mbytes for itsalf,
depending on the version)



Mouse, Keyboard, and Color Monitor

* Y ou now possess space age technology for audio restoration. 1f you haven't yet replaced your bundled
sound card (which is probably the lowest quality audio component you own), contact Tracer Technologies
or visit www.tracertek.com

** |f your computer has more than the minimum required to run your OS adequately (64 Mbytes on 98SE,
128 on XP), further increases in the quantity of RAM will not appreciably speed up the MILLENNIUM
algorithms since they are almost totally bound by the processor. Upgrading to a faster processor WILL
allow the filters to run much faster.

Step Two - Installation of Product
Thisis pretty straightforward stuff.

1. If you downloaded the program, just double-click theicon. If you received the program on a CD, put
theinstall CD into your drive. If Auto-run is enabled, installation will begin immediately. If not:
Click the “Start” Button, choose “Run” from the pop-up menu

Click the “Browse” Button and point to your CD ROM Drive

Find the dcautorun.exe icon and double click on it

The Diamond Cut install program will start. Follow the instructions on the screen.
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The software will be installed in afolder called Diamond Cut Productions. A demo wave fileisalso
supplied as part of the demonstration tutorials in both the Help file and manual.

Installation from this point just consists of basically clicking “Next”. Just do what the installer asks.

Step Three - Configure Your MILLENNIUM Program

MILLENNIUM does not require any difficult configuration, but it does require that your sound card be
installed and working properly. If you have more than one sound card in your system, make sure the one
you wish to use has been selected in the Sound Card Selection screen (use the Edit/Preferences/Device 1/0
Menu Item).

Next, check the Temp File Path under the Edit/Preferences menu. MILLENNIUM automatically assigns
temporary file namesfor filesthat are being processed. Y ou should set the temporary drive path for the disk
drive that you wish to use for audio editing. Thisis usually the drive with the most free disk space. Keep in
mind that high quality (44.1KHz) stereo recording consumes 10.4MB of disk space per minute.

Generally, thisis where we get calls from customers who experience one form of problem or another. This
is usually because most people don't record onto their computer’ s hard drive very often and they may not
have their system set up for this type of application. Before you call us...read the next few paragraphs:

1. Make sure you have the output of your audio source (tape player or turntable/preamp) plugged
directly to the Line input of your sound card. (Do Not Use the Mic Input of your sound card).

2. If you have aturntable, make sure that you are using either a stereo preamp or the Tape Out on
your Stereo system in between the sound card and the turntable. Y our turntable cannot generate
enough signal on its own to make a good line level recording. You'll need the additional boost
applied by either the Tape Out or the Preamp.

3. If youtry to play or record and you get the message “ Cannot play the specified format...etc.”
This is a message generated by Windows...not our product. It istelling you that MILLENNIUM
istrying to play a Wave file through a device that is not able to do this. This could be aresult of
Windows having aModem listed as the primary device for playing Wave files...or some other non
Wave device. Check in your control panel settings to make sure that your sound card is listed as



the primary playback device. Also, make sure the MILLENNIUM is set correctly for your sound
card under Edit/Device |/O.

4. If you arerecording and can hear audio playing through the speakers but the record VU meters are
not jumping, then check your sound card’s mixer. Many times, the Recording mixer is turned
down or muted. Just find the mixer (in many casesit’s alittle yellow or blue speaker icon located
in your Windows Tray beside your clock). Double click thisicon. Now go to Options/Properties
then click on Recording and then click OK.. Make sureyour Line Input is selected in this mixer —
not your mic input.

Step Four — Connect Your Computer To Your Audio System

Y our sound card has both an input and an output. The output is used when you play an audio file and the
input is used when you record audio into the computer. Refer to your sound card manual or the little icons
on your soundcard to identify which jack is for output (playing back audio) and which is for input
(recording audio).

We first want to connect speakers to the output of your sound card so we can hear audio. Y ou probably
already have speakers connected. If you do, then fine. Just leave them aone. If not, you'll need to
connect the output of your sound card to either an amplifier or amplified speakers with line level inputs.

Note: Your sound card records and plays audio at a certain known level. This standard level isreferred to
asLineLevel. Just about all devices play or record with this exact audio level so they’re al compatible
with each other. CD players, Tape Recorders, Amplifiers, Receivers, VCRs, DAT machines, Mini discs
and most other devices all play or record this standard Line Level signal. This means you can plug your
tape player output or other line level device directly into the input of your sound card since they both use
the same type level of signal.
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Figure 1- Wiring Things Up!

Next, we need to plug some audio into the Input of your sound card so we can record this audio into your
computer. If you are using aline level device, just plug it into the sound card line level input using
whatever adapter cable mates your player device (i.e., tape recorder) to the input jack on your sound card.

Big Note on Turntables - There are two common playback devicesthat are NOT line level and which
CANNOT be plugged directly into the line level input of your sound card. Thefirst isa Turntable with a
magnetic phono cartridge. A magnetic phono cartridge puts out a signal that is much smaller than line
level. Your sound card cannot use thissignal asit is—it must be amplified up to a standard Line Level
before it gets to your sound card.




Therefore, you must use what is called a preamplifier. If you have a stereo system with an input jack on the
back-labeled “phono”, you aready have a preamp. It'sin your stereo system. Just leave your turntable
connected to the Phono-1n of your stereo and connect aLine Level output of your stereo to the sound card
input. Many times, this line level output is marked as “ Tape Out”. Now, any audio (including your
turntable) you can hear from your stereo system will be available to your computer for recording.

If you don’'t have a stereo system to connect your turntable to, or it’s in another room, you' [l need a stand-
alone preamplifier. These are not expensive and you can get one at www.tracertek.com. Again, this takes
the tiny signal from your turntable and amplifiesit so that it’s now a standard line level signal that can be
plugged directly into your sound card.

Another device that does not put out a standard Line Level signal isamicrophone. If you want to record
from amic, just plug the mic into the jack on your sound card that is |abeled Microphone. If you need to
use this mic jack, again, refer to your manual for your sound card for specifics.

In most cases, you'll simply either be taking the output of your source to the input of your sound card. This
is pretty easy to visualize since the computer is really acting like a familiar tape recorder with an input and
an output. Many audiophiles have very sophisticated and complicated audio systems that allow many
different kinds of hookups. Therefore, there are many alternative methods for connecting your computer to
a sound system in order to be able to use MILLENNIUM. If you have questions about any specific
hookup, feel freeto call Tracer at 717-764-9240.

Step Five — Turn Screen Saver and Background Tasks Off

In some cases when recording, if your screen saver or other background task automatically comes on, it
may interrupt your recording or add glitches that you didn’t want. It is aways better to turn this off before
recording. Though thisisless of aproblem with faster computers, most users will feel more secure if they
turn off automatic backups, screen savers, etc. This allows the computer to fully concentrate on recording
clean audio.

Step Six — Testing Your System

By now you should have installed the software and connected your speakers to the sound card output and
some audio playback device (such as atape player) to the sound card input. It's time to make sure your
efforts have borne fruit.

The first thing we're going to do is run the MILLENNIUM program. Do this by double clicking theicon
on your desktop. Put away the tips screen and click on File/Open Source. You'll now see afamiliar
windows file selector box. Navigate to c:/program files/diamond cut productions/DC
Millennium/Wavefiles. Openthefile called Demol. Thisisastandard .wav file and was included with the
program. We Il actually clean up thisfile in the next section, but for now we just want to play it.

Oncethefileis selected, it will open in the program and you' Il see the graphic drawing of the audio
waveform on your display. It will look like this:
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Figure 2- A fileis opened

Notice all the niceicons at the top of the display. If you move your mouse over any one of them and leave
it there for a second, alittle box will open telling you what that icon does. To play our file, we need to find
thelittleicon that looks like aright pointing triangle. Thisisthe standard symbol for “play” that you'll find
on any tape deck. Click on thisicon and you should hear audio and see the cursor move. Note: if you
aren’t getting audio at this point, check out our troubleshooting steps later in the manual.

Let the audio play to the end of the file and it will stop automatically and reset itself so you can play it
again. Let'splay it again using a keyboard shortcut. Shortcuts are simply keys on your keyboard that
perform a function without having to use the mouse. Power users love shortcuts and the Play shortcut is
the easiest of all. Just hit the spacebar now and the audio starts playing. Hit the spacebar again to stop the
audio from playing. Easy, isn’t it? Many beginners like to spend hours doing this, but let’s move on to test
the recording capability of your system.

For our recording test, we' re going to assume you have a tape recorder connected to the input of your
sound card. A CD player or even aturntable with a preamp uses exactly the same process, so just make
sure you' re hooked up correctly.

To record, start your tape recorder playing a pre-recorded tape (or start playing an LP, etc). Y ou should
hear the audio coming from your speakers. Now click the red Record button on the toolbar in
MILLENNIUM. A nice record screen comes up which looks like this:
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Figure 3- The Record Window



This screen will allow you to set the recording parameters and make sure the recording is happening
correctly. Let’s start by making sure we are set to record a stereo file at 44.1 KHZ, 16 bit. Just use the
drop down boxes to select these parameters. Note the Recording Device box. Y our sound card should be
listed here. If not, drop the box down and choose the sound card input that has the audio being fed to it.

Start your tape player playing some audio and click the Pause button in this window. This puts the
program into what is called Record/Pause mode. The VU meters on the left should now start dancing as
the program is actually seeing the audio from your tape recorder.

If those meters are dancing, you are now done with testing your installation. Click Stop, and then click
Close. Answer “yes’ when the program asks if you want to discard this recording. Y ou now have a
perfectly working audio restoration workstation and you can go on to the next section where we'll teach
you to use this powerful tool.

If you found that your meters didn’t jump when you hit the Pause button, the problem is very likely caused
by your sound card being set to the Mic input and not the Line Level input. This common problem is easily
and permanently solved by double clicking the little yellow (in’98) or blue (in XP) speaker icon in your
tray —just to the left of the clock on the bottom of your screen. Now choose, Options, then Properties.
Click the record button and then click OK. Now click the check box under Line Input and your meters will
start to jump in MILLENNIUM indicating that all is now well. You just turned on the Live Level input —
which iswhere our audio is, after al.

Now that your system has been installed and checked, it’s time to get to the software and perform an actua
restoration project.

Section Two — Our Step-by Step Guide
This will teach you to actually use the DC Millennium

Step By Step Guides
In this section, we're going to take you by the hand and lead you through some complete examples of
typical restoration projects. You'll remove noise and “sweeten” the audio. When you are done, you'll be

licensed to drive the product yourself without training wheels.

This entire training process will take you about 10 minutes and will give you all the basics you need to
know to use the program. Please follow along step by step thru the examples, but try not to get ahead.

In these Guides, we'll tell you exactly what to do and even explain why it is you are doing these things.
It'simportant that you follow along exactly as one step builds upon the next.

Note: The actions you are expected to take are highlighted in Bold. Do the steps as we suggest and don’t
get ahead or you'll get astern talking to. Let’'s get started !

Easy Record Restoration Step By Step Guide

First, we need to run the program. If it’snot already up, just double click theicon on your desktop to start
it. MILLENNIUM starts with atip screen, which offers quick suggestions as to how to use the program.
Y ou can disable this by clicking on the check box in this screen.

Next, open the Demol Wave file the way we did in the testing section above.

Listen to thisfile by either clicking the Play button or hitting the spacebar —it’s full of clicks, hiss, low
frequency noise, etc. It'samess. Stop the playback when you're done listening.



Y ou work with MILLENNIUM by choosing filters to apply to audio. Some of the filters remove noise and
others enhance the audio though they are all referred to in this guide asfilters. You choose afilter by
identifying the type of noise you want to remove and then selecting the filter that removes that type of
noise. Make sense so far, right?

In just about every case when clicks and pops are present, we want to remove them first. Trust us, thisis
the right first step whenever you get clicks and pops on records or other recordings.

To remove the clicks, we'll choose the Impulse filter. Clicks are short noise impulses so it makes sense to
use thisfilter. To choose thefilter, click on the Filter menu item and choose the-l mpulse Noise Filter.
You'll seethefilter open like this:
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Figure 4- The Impulse Filter Appears

Note that the filter takes up only a portion of the screen. You can still see part of the waveform and all the
menus and icons. Y ou can move this filter window around on your screen and position it wherever you
want. Just grab thetitle bar at the top of the filter window and drag it around. Try it now.

Now let’s focus on the filter itself. Just about EVERY filter in MILLENNIUM will work the way this one
does. Once you learn this onefilter, you'll be able to use them all! Because of this, we're going to cover
thisfilter in great detail. Be sure and follow along.
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Figure5- The EZ Impulse Noise Filter



In the filter window, you will see several features. First, you'll notice sliders that control various filter
parameters. These sliders can be adjusted while you listen to the audio so you will instantly hear the result
of any changes you make.

Next, you'll have Radio buttons that control other aspects of the filters. Again, you can change them while
listening, so you'll hear the results instantly. The Radio buttons in the Impulse filter are Speed and
Accuracy.

In every filter, you will have a Preview button. Thisis the most important button here. This button will
start the audio playing while the filter is processing it. You will hear the results of thefilter instantly. This
makes for easy adjustment of the filters.

Alsoin every filter, you will have a Bypass checkbox. This takes the filter in and out of the audio stream
instantly. When you listen to afilter being applied by the Preview button, you may want to be able to
compare the processed audio to the original audio. Clicking this checkbox will bypass the filter and you'll
be hearing the original audio. Unchecking it will instantly put the filter back into the signal path. This
way, you can “fine tune” even subtle effects with MILLENNIUM.

Lastly, every filter will have controls for Presets. A preset is asaved group of settings for thisfilter. Go
ahead and drop down the Preset box now — it’ s the white box at the bottom of thefilter. Click on some of
the presets and watch the sliders as they move to good starting points for common tasks. You can tell alot
by looking at the name of the presets. Now select the preset labeled Demo Audio Wavefile Declick. This
oneisaready set up with good settings for our Demol file. Every filter will also have a Save and Delete
button that allows you to save your own presets under any name you want — and del ete them too!

You're probably ready to try this filter by now, but there is one more thing that is common to each filter
that you should know. Don’t close the Impulse Filter, but Click on the Help dropdown at the top of the
program screen. Now click on Contents and choose Filter Tutorials. Now click on the Impulse Filter.
Notice that this gives you a complete explanation of each control in thefilter. Thistype of help isavailable
for every function in the program.

Put the Help screen away and let’s clean some audio. If you've aready been listening to thisfilter, then
shame on you for jumping ahead. Simon has not said click the Preview button yet. As punishment, please
go back to page one of this manual and start reading again. We'll wait for you here.

Welcome back. Now let’s get started by clicking the button labeled Preview. Y ou will hear the audio asit
isbeing filtered. Y ou will still hear the low frequency rumble and the hiss, but the clicks should be gone.
Let it preview all the way to the end of the file. Notice that once it reaches the end, it will automatically
start over at the beginning. Thisis called Looping and is automatic when you are previewing with afilter
(thought it can be turned off in the Edit/Preferences screen).

Let’sjust confirm that the clicks are gone. To do this, check the Bypass box in the filter whileit is till
previewing. Now the filter is bypassed and the clicks will once again be audible. Listen for awhile and
then uncheck the Bypass box. Now the filter is again doing it job and the clicks are no longer heard.

It'stime to learn how to adjust afilter. While you are previewing, move the tracking slider all the way to
thetop. Thismakesthefilter less aggressive and it will filter less. Notice that the clicks have returned
now. Slowly move the tracking slider down and you’ll hear more and more of the clicks getting removed.
All the filters work this way — you just adjust them while you listen. Asyou might expect, if you move
them too far you'll make the filter too aggressive and you'll get distorted, stuttering or otherwise bad audio
— just move them enough to get the desired result. Set the tracking back to a setting of 1.

While you are still previewing, note the Progress window shown below. Thiswindow shows the total
number of clicks as well as the click/second that are being found and repaired. For most recordings, you'll
be set in the ballpark when you are finding between 10 and 30 clicks per second. Thiswill jJump around
some, which isnormal. Now click on Cancel in the Progress window:
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Figure 6- Monitor your progress

This stops the preview from playing. By Previewing, we have adjusted the filter and confirmed that it is
doing itsjob. The next step isto click on the Run Filter button. Thistakesthefilter just asyou have set it
and appliesit to the demol file and creates a new file in the lower window. This new file has been run
through the filter and has the clicks removed. At this point, click on Closein the Impulse filter window
since we're now done with it.

Look at the two waveforms. The top oneis called the Source. Thisiswhere we normally work on afile,
preview filters, etc. The bottom is called the Destination and is the result of our filtering efforts. Y ou can
play either one by clicking in the respective window. Y ou have not changed your original file at all —
rather we' ve created a new cleaned up version.

Now it’s time to remove that rumble sound, but how can we do that if we work on the Source window and
we really want to remove the rumble from the semi-clean file in the Destination window? The answer isa
little command under the File menu called Make Destination the Source. This moves the file in the bottom
window up to the top where we can work on it. Click on File/Make Destination the Source now.

A File Selector box will come up and suggest a new name for thisfile; just click on Save to accept it.
Note: MILLENNIUM will automatically assign sequential names to new files. While you're new to the
program, always just accept its recommendation as to file names.

Now we are ready to remove that low frequency rumble. To do that, we'll choose the High Passfilter.
Click on Filter/High Pass now. A high passfilter will remove all frequencies below a certain point and
allow al higher frequenciesto pass. Drop the preset box and select the preset called “ Demo audio Wave
file de-rumble”. It'll look like this:
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Figure 7- The Highpassfilter

WEe'll start to go a bit quicker now since you already know what most of the buttons and controls do on this
filter. To find out specific info on thisfilter, don’t forget you can call for help clicking on the Help menu
item. We are going to free you now to preview and play with thisfilter on your own, but when you're
done, return it to these settings by once again clicking on the demo Wave file preset. Run the filter when
you are ready. Note: There's quite alot of low frequency rumble in thisfile, but if you have cheap
computer speakers, you may not be ableto hear it. Trust us, it’s there.



Y ou now have removed two of the annoying noise typesin thisfile. First, we rid ourselves of the clicks
and pops, and then we removed the rumble. Now it’stime to get rid of that loud hiss sound. First,
remember to move our Destination file up to the Source window.

Now click on Filter and select the Continuous Noise Filter. Thisfilter is perfect for hiss and other types

of continuous noise. Also, click on View and make sure you have Time Display checked at thistime. The
Time Display box shows you various timing cal culations with the program and will come in handy as you

will see. Your screen should look something like this:
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Figure 8- The Continuous Noisefilter isawake

The Continuous Noise filter is one of the most powerful in the whole program so follow along carefully
here. Thisfilter will remove just about any continuous noise in afile, but it needs you to give it a sample of
thisnoise. Once it isable to examine the noise, it will be able to seek it out and get rid of it. Play thefile
now using the Play button at the top and listen carefully to the first couple of seconds. You will hear an
arearight at the beginning, which contains only the noise and no good audio. That's a great spot from
which to grab a sample of the noise.

To do this, we need to click and drag with our mouse to select this area. The area highlighted in yellow in
the illustration above is the area we want to select. Just click about %2 inch from the left edge and, while
holding the mouse button, drag all the way left. Let the mouse button go and you will see an area
highlighted in bright yellow. Thisis the areayou have selected. Move the mouse pointer over either edge
of the selected area and the pointer will turn into a Left/Right indicator. Click and drag as necessary to
select an area from the beginning of thefile that is about .5 seconds long. Use the” Span=" display in
the timer window to confirm that your selection is around %2 second long. Again, you'll end up with a
yellow selected area similar to the one shown above.

Now hit the spacebar. You'll play only the selected area. It’'ll be quick. Thisallows you to audition a
selected area to make sure you are really working on the correct area (does not contain silence or desired
signal). You should only hear the hissing noise.

It'stimefor the fun part. You will like this. Hit the Sample Noise button in the Filter window. Thefilter
will analyze the noise sample and will display the frequency characteristics of the noise in red. The blue



lineisthefilter that is designed to get rid of thisnoise. Notice how they track with each other. Yours
should look like this:
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Figure 9- Continuous Noise Filter doesitsjob

If you have jumped ahead again and clicked on Preview, there will be no lunch for you today. First, we've
got to explain those little blue dots on the filter line. Notice how the blue line is above the red noise
sample? The higher the blue filter line, the more filtering occurs at that frequency. The blue dots are
called Control Points and allow you to manually adjust the amount of filtering for frequency componentsin
the vicinity of the control point. We're going to do that in a second, but the Help file contains all the
complete info on thisfilter.

Before we click on Preview, we need to again select the whole file so we'll hear the whole thing and not
just our ¥2 second noise sample that is now selected. To select the wholefile, jusdouble click anywhere
in the waveform display. Notice how the whole thing gets highlighted in yellow. Now, go ahead and
click on Preview.

Listen to the audio. The clicks are gone. The rumbleis gone and the hissisgone! Well, not quite. You
can still hear a bit of hiss can’'t you? While Previewing, click the bypass button a few times to take the
filter in an out of the signal path. Yes, the hissis reduced, but thereis still some of it there. Let’s adjust
thisfilter to get rid of all of the hiss.

Make sure your bypass button is NOT checked and make sure you are previewing the audio. Now grab
the 4™ control point from the right side and move it up a bit as shown below.
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Figure 10- Tackling the remaining hiss

It'slike magic, isn't it? The hiss completely goes away because you told the filter to be a bit more
aggressive on the high frequencies. Remember, moving the blue line up makes it filter more. Now stop
the preview, click on Run filter, and close the Continuous Noise filter.

Y ou now have a Destination file that is completely restored. To finish, click on File/Make Destination the
Source, accept the file name and you're done. Thisfileisthe completed version and all others can be
deleted or saved if you want each processing step before and after the saved file. Y ou can now exit the
program or close the files using the commands under the File Menu.

What you’ve learned in this guide

In this quick Step by Step guide, you' ve learned how to launch the program, how to select filters, how to
preview them, how to bypass them, how to load and save presets, what are Source and Destination files,
how to apply multiple filters to a single file, how various filters work and much more. Not bad for afew
minutes! Next, we'll give you a more advanced Step by Step in which you get to use the most powerful
feature of MILLENNIUM, the MultiFilter.

Advanced Record Restoration Step By Step Guide

You learned alot in the last Step-by-Step Guide, so let’s continue by restoring this same file using a
completely different approach. Thiswill show you the flexibility and power of MILLENNIUM and will
introduce you to our powerful MultiFilter. We'll assume you' ve done the Basic Guide above and are
therefore comfortable with the basic functions of the program so we will take this at a little faster pace. As
before, the actions are expected to perform will be in Bold type. Let’s get started!

Now open the Demol Wave file in the same way we did before.

Now click on Filter and choose MultiFilter. Double click anywhere in the waveform display to select the
entire file for processing or left click and drag to select a segment of the file. Notice how MILLENNIUM
allows you to select an area or the entire file while the filter windows are open. Thisis avery handy
feature.

The MultiFilter is one of the most powerful features of MILLENNIUM. It allows you to string together
severa filters and preview or apply them sequentialy or al at once. Thissavesalot of time and makes it
possible for users to create some incredibly sophisticated filter setups.

Notice that the MultiFilter has an input on the left side and an output on the right side. Between the input
and output isasignal path. You can drag any filter you want into this signal path. At thistime, remove
any filtersthat arein the signal path by clicking on them and dragging them out of the signal path.



Remember when we did the Basic Step by Step Guide above, we used three filters; the Expert Impulsive
noise filter for clicks, the High Pass filter for rumble and the Continuous Noise filter for the hiss. Drag
these threefiltersinto the signal path with the Expert Impulse filter on the left side followed by the High
Pass filter and then the Continuous Noise filter on the rightmost side. Now double click on the Impulse
filter icon in the signal path of the MultiFilter. Y our screen should look something like this:
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Figure 11- Working with the MultiFilter

To open the individua settings for any filter in the MultiFilter signal path, just double click it and make
your settings. For the Impulse filter, drop the preset box and choose “ Demo Audio Wave file Declick” .
You could preview and adjust while listening here, of course, but we've already got some good settings
available as apreset. Close the Impulse filter window.

Now Double click on the High pass filter and select the “ Demo Audio Wave file De-Rumble’ preset.
Close the High Pass filter window when done.

Lastly, open the Continuous Noisefilter and choose the “ Demo Audio Wave file DeNoise” preset. Close
thewindow. We used these presets only because they are available. Y ou can aways choose any preset or
you can set the filters yourself by just previewing as we did in the Basic Step by Step guide.

Note: Each individual filter can be previewed even in the MultiFilter by clicking itsindividual preview
button..

Now we have three filters strung together. Click the Preview button in the MultiFilter window. The
Multifilter preview button allows you to hear ALL the filters being applied at once. Y ou will hear the
audio being filtered by all three of these filters. Click the Bypass button a few timesto marvel at what is
happening here. Feel free to giggle and then cancel the preview.

Now we're going to add afourth filter. Drag the Paragrahic EQ into the signal path and put it last in line
(on the rightmost side). Double click the Paragraphic EQ to open its adjustment window. Click on the
Reset Level button in the Paragraphic EQ to make it flat. Now click on the MultiFilter Preview button.
Y ou may have to move the Paragraphic out of the way to access this button. Y ou are now hearing the
audio filtered thru 4 filters. Make surethe Bypass button is not checked. While the preview is happening,
find the blue control point in the Paragraphic EQ which is close to 110Hz. Y ou can see this on the
horizontal scale on the bottom of the EQ adjustment area. Move this up to increase the bass frequenciesin
our old recording. The more you move it up, the more low frequencies you get. It should look like this:
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Figure 12- Using the Paragraphic EQ

Y ou should notice that you are applying all four filters at once and you are adjusting one of them. The
results of your adjustments are instantly heard while all the filters are being applied. Cancel the preview,
run thefilter, Make Destination the Source.

What you’ve learned in this Advanced Step by Step Guide

Y ou now know how to use multiple filters at once and how to Preview all or any of them. You also now
know how to follow our instructions and you are now fully oriented with DC Millennium and should be
able to record in your own audio and clean it up as we did here.

While DC Millennium is avery powerful program and you'll find it addictive — in a positive way, of
course. Many users get DC Millennium with the idea of restoring afew treasured recordsin their
collection, but then get “the bug” and pick up afew hundred more records at ayard sale. If you find you
really enjoy restoring old audio, you should consider upgrading to the big brother of DC Millennium —
DC5. Thisprogram has a gigantic number of additional features, isfaster and iseven easier. It even comes
with a 380 page printed manual. Upgrades from DC Millennium to DC5 are available. Just call Tracer at
717-764-9240 to get the latest version of DC5.



